
 
 

Concurso Público / Edital n. 01/2012 

 

Desenhista 
Código 203 

 

LEIA COM ATENÇÃO AS INSTRUÇÕES DESTE CADERNO. 
Elas fazem parte da sua prova. 

 

Este caderno contém as questões de Língua Portuguesa, Conhecimentos Gerais/Legislação 
e Conhecimentos Específicos.  
 

Ao receber a Folha de Respostas: 

 confira seu nome, número de inscrição e cargo de opção; 

 assine, A TINTA, no espaço próprio indicado. 
 

 

 

 

 

 

 

 

 

  NÃO DEIXE NENHUMA QUESTÃO SEM RESPOSTA. 
A Folha de Respostas não deve ser dobrada, amassada ou rasurada. 

  CUIDE BEM DELA. ELA É A SUA PROVA. 
 

ATENÇÃO – Poderá, ainda, ser eliminado o candidato que: “[...] portar arma(s) no local de 
realização das provas, ainda que de posse de documento oficial de licença para o respectivo porte; 
[...] portar, mesmo que desligados, durante o período de realização das provas, quaisquer 
equipamentos eletrônicos como relógio digital, calculadora, walkman, notebook, palm-top, [...], ou 
instrumentos de comunicação interna ou externa, tais como telefone celular, bip, pager entre 
outros, ou deles fizer uso; [...] ” (itens 8.1.29 “d”, “e”) 

DURAÇÃO MÁXIMA DA PROVA: QUATRO HORAS 

 

 

Ao transferir as respostas para a Folha de Respostas: 

 use apenas caneta esferográfica azul ou preta; 

 preencha, sem forçar o papel, toda a área reservada à letra 
correspondente à resposta solicitada em cada questão; 

 assinale somente uma alternativa em cada questão. Sua resposta 
não será computada se houver marcação de mais de uma 

alternativa, questões não assinaladas ou questões rasuradas. 
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A T E N Ç Ã O 
 

Sr.(a) Candidato(a). 
 
 

Antes de começar a fazer a prova, confira se este caderno 

contém, ao todo, 40 (quarenta) questões objetivas – cada uma 

constituída de 4 (quatro) alternativas – assim distribuídas:        

Língua Portuguesa — 15 (quinze) questões, Conhecimentos 

Gerais/Legislação — 10 (dez) questões e Conhecimentos 

Específicos  —  15 (quinze) questões, todas perfeitamente 

legíveis. 

 
Identificando algum problema, informe imediatamente ao 

aplicador de provas para que ele tome as providências 

necessárias. 

 
Caso V.Sa. não observe essa recomendação, não lhe caberá 

qualquer reclamação ou recurso posteriores. 
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Língua Portuguesa 

 
 

INSTRUÇÃO  As questões de 1 a 15 relacionam-se com o texto abaixo. Leia-o 
atentamente antes de responder a elas. 

 
 

O PODER DA FORÇA DE VONTADE 

Débora Rubin 
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I.D. é gerente de marketing em uma academia no Rio de Janeiro. E, acredite, 
até ela precisa ter muita força de vontade para malhar. Não porque não goste dos 
treinamentos ou os considere desnecessários. É que exercitar o corpo 
regularmente, comer de forma saudável, entregar trabalhos no prazo, manter a casa 
limpa e cumprir metas são atitudes que vão contra duas das maiores tentações do 
ser humano: o prazer e a preguiça. Para lutar contra essas tendências, é preciso 
fazer uma verdadeira ginástica mental. É o que prega o livro Willpower: 
rediscovering our greatest strength (Força de vontade: redescobrindo a nossa maior 
força, em tradução livre), lançado recentemente nos Estados Unidos e já um dos 
mais vendidos da lista do “The New York Times”. Segundo os autores da obra, o 
psicólogo da Universidade da Flórida Roy F. Baumeister e o jornalista John Tierney, 
o treino diário da nossa “maior força”, como chamam, é o melhor antídoto para a 
preguiça e a busca incessante de satisfação. E, quanto maior a força de vontade, 
maiores as chances de ter uma vida saudável. “É a chave do sucesso e da 
felicidade”, argumenta Baumeister. Parece exagero, mas não é. Nos estudos 
citados pelos autores, vários deles mostram que as pessoas com menos força de 
vontade são aquelas mais suscetíveis a problemas como alcoolismo, obesidade e 
vício em drogas. 

Difícil, no entanto, é ter esse controle em uma sociedade cada vez mais 
hedonista(1). ―A vida não permite satisfação o tempo todo, mas mesmo assim 
queremos nos manter nesse estado‖, explica o psicanalista e professor R.A.M., 
especialista em saúde e bem-estar. “E toda hora vai ter alguém te empurrando para 
a festa, para o bar, para a sobremesa mais gordurosa, o que torna ainda mais 
complicado fazer esse exercício mental.” O psicanalista aconselha a trocar o 
conceito de felicidade, que remete aos prazeres momentâneos, pela ideia de bem-
estar. O lado negativo da força de vontade acontece quando há um exagero e o 
bem-estar vira um tormento. Pessoas com pouca flexibilidade podem transformar 
autocontrole e disciplina em neurose e obsessão, como os que malham 
compulsivamente, os que cortam radicalmente doces e bebidas e os que só 
economizam dinheiro. 

 
 ISTOÉ, 29/02/2012. (Texto adaptado) 

 
(1) Hedonista – que considera o prazer como bem supremo. 
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Questão 1 

No texto apresentado, principalmente, 
 
A) descrevem-se objetos. 

B) expõem-se ideias. 

C) narram-se acontecimentos. 

D) reproduzem-se diálogos. 
 
 
 

Questão 2 

Nesse texto, focaliza-se, principalmente, 
 
A) um comportamento habitual. 

B) um costume raro. 

C) uma faculdade humana. 

D) uma maneira de ser. 
 
 
 

Questão 3 

No texto, NÃO se pretende estimular as pessoas a uma vida 
 
A) mais equilibrada. 

B) mais feliz. 

C) menos estressante. 

D) menos interessante. 
 
 
 

Questão 4 

“A vida não permite satisfação o tempo todo [...]” (linha 20) 
 
Essa frase, no texto, exprime uma constatação 
 
A) hipotética. 

B) imaginosa. 

C) pessimista. 

D) realista. 
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Questão 5 

“O lado negativo da força de vontade acontece quando há um exagero [...]” (linha 26) 
 
É CORRETO considerar que essa frase, no texto, significa um 
 
A) alerta. 

B) desafio. 

C) despropósito. 

D) equívoco. 
 
 
 

Questão 6 

“[...] os que malham compulsivamente [...]” (linhas 28-29)  
 
A palavra sublinhada nesse fragmento de frase pode ser adequadamente substituída, no 
texto, por 
 
A) deliberadamente. 

B) incessantemente. 

C) obrigatoriamente. 

D) prazerosamente. 
 
 
 

Questão 7  

“[...] os que cortam radicalmente doces e bebidas [...]” (linha 29) 
 
Nesse fragmento de frase, NÃO se pode considerar que a palavra sublinhada tenha o 
sentido de 
 
A) completamente. 

B) integralmente. 

C) ousadamente. 

D) totalmente. 
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Questão 8 

“Não porque não goste dos treinamentos [...]” (linhas 2-3)  
 
A forma verbal sublinhada nessa frase está conjugada no 
 
A) futuro. 

B) imperfeito. 

C) perfeito. 

D) presente. 
 
 
 

Questão 9 

“E, quanto maior a força de vontade, maiores as chances de ter uma vida saudável.” 
(linhas 13-14) 
 
Essa frase está estruturada a partir de uma ideia de 
 
A) alternância. 

B) comparação. 

C) conclusão. 

D) exclusão. 
 
 
 

Questão 10 

“Nos estudos citados pelos autores, vários deles mostram que as pessoas com menos 
força de vontade são aquelas mais suscetíveis a problemas como alcoolismo, obesidade 
e vícios em drogas.” (linhas 15-18) 
 
A expressão sublinhada nessa frase pode ser analisada, sintaticamente, como 
 
A) adjunto adnominal. 

B) adjunto adverbial. 

C) agente da voz passiva. 

D) predicativo. 
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Questão 11 

“Difícil, no entanto, é ter esse controle [...]” (linha 19) 
 
A conjunção sublinhada confere à frase a que pertence um sentido de 
 
A) adição. 

B) consequência. 

C) finalidade. 

D) oposição. 
 
 

Questão 12 

“A vida não permite satisfação o tempo todo [...]” (linha 20)  
 
A expressão sublinhada tem, nessa frase, um sentido de 
 
A) espaço. 

B) modo. 

C) origem. 

D) tempo. 
 
 

Questão 13 

“[...] explica o psicanalista e professor R.A.M., especialista em saúde e bem-estar.” (linhas 
21-22) 
 
A expressão sublinhada nessa frase pode ser classificada como um 
 
A) aposto. 

B) predicado. 

C) sujeito. 

D) vocativo. 
 
 

Questão 14 

“O lado negativo da força de vontade acontece quando há um exagero [...]” (linha 26)  
 
A oração sublinhada será adequadamente classificada como 
 
A) causal. 

B) conformativa. 

C) consecutiva. 

D) temporal. 
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Questão 15 

“Pessoas com pouca flexibilidade podem transformar autocontrole [...] em neurose e 
obsessão [...]” (linhas 27-28) 
 
A expressão sublinhada nessa frase explicita uma 
 
A) exclamação. 

B) generalização. 

C) qualificação. 

D) quantificação.  
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Conhecimentos Gerais/Legislação 

 

Questão 16 

Ser cidadão significa ter direitos e deveres. 
 
São considerados deveres do cidadão, EXCETO 
 
A) fazer parte do governo, direta ou indiretamente, ao votar. 

B) poder se expressar livremente. 

C) ser o próprio fomentador da existência dos direitos a todos. 

D) ter responsabilidade em conjunto pela coletividade. 
 
 
 

Questão 17 

Para análise e para facilitar a compreensão, Covre (1993) divide a cidadania em termos 
de direitos civis, políticos e sociais. 
 
Segundo a referida autora, é INCORRETO afirmar que os direitos políticos dizem respeito  
 
A) à convivência com os outros homens em organismos de representação direta ou 

indireta. 

B) ao direito de se dispor do próprio corpo, locomoção e segurança. 

C) ao direito de ter livre expressão de pensamento e prática política e religiosa. 

D) à deliberação do homem sobre sua vida. 
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Questão 18 

De acordo com Valls (1996), a ética é um conceito que sempre esteve presente em todas 
as sociedades. 
 
Analise as seguintes afirmativas referentes à ética e assinale com V as verdadeiras e 
com F as falsas. 
 
(    ) A ética contemporânea preocupa-se com o julgamento do sistema econômico como 

um todo. O bem e o mal existem apenas nas consciências individuais. 

(    ) Os valores éticos podem se transformar, assim como a sociedade se transforma. 

(    ) A ética, tradicionalmente, é entendida como uma reflexão científica ou filosófica 

sobre os costumes ou sobre as ações humanas. 

(    ) A ética pode ser o estudo das ações ou dos costumes e pode ser a própria  

realização de um tipo de comportamento. 

 
Assinale a alternativa que apresenta a sequência de letras CORRETA. 
 
A) (F) (V) (V) (V) 

B) (V) (F) (F) (V) 

C) (V) (V) (V) (F) 

D) (F) (V) (F) (V) 
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Questão 19 

De acordo com o Estatuto da Criança e do Adolescente (ECA), o Conselho Tutelar é um 
órgão permanente e autônomo, não jurisdicional, encarregado pela sociedade de zelar 
pelo cumprimento dos direitos da criança e do adolescente. 
 
Considerando o trecho acima, assinale com V as afirmativas verdadeiras e com F as 
falsas. 
 
(    ) Em cada município haverá, no mínimo, um conselho tutelar composto de seis 

membros escolhidos pela comunidade. 

(    ) Os membros escolhidos terão de cumprir o mandato de dois anos. 

(    ) Para ser membro de um conselho tutelar, o candidato deverá ter idade superior a 

vinte e um anos. 

(    ) O candidato deverá obrigatoriamente residir no município onde o conselho tutelar 

para o qual se candidata está instalado. 

 
Assinale a alternativa que apresenta a sequência de letras CORRETA. 
 
A) (V) (V) (F) (V) 

B) (F) (F) (V) (V) 

C) (V) (F) (V) (F) 

D) (F) (V) (F) (V) 

 

Questão 20 

De acordo com o Art. 56 do Estatuto da Criança e do Adolescente, os dirigentes de 
estabelecimentos de ensino fundamental comunicarão ao conselho tutelar os seguintes 
casos, EXCETO 
 
A) maus tratos envolvendo seus alunos. 

B) reiteração de faltas injustificadas e de evasão escolar, esgotados os recursos 
escolares. 

C) elevados níveis de aprovação. 

D) elevados níveis de repetência. 
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Questão 21 

A Lei n. 10.741/2003 dispõe sobre o Estatuto do Idoso. 
 
Considerando os artigos 20, 21, 22, 23, 24 e 25 que se referem à educação, cultura, 
esporte e lazer, assinale a afirmativa INCORRETA. 
 
A) O Poder Público criará oportunidades de acesso do idoso à educação, adequando 

currículos, metodologias e material didático aos programas educacionais a eles 
destinados. 

B) Os cursos especiais para idosos incluirão conteúdo relativo às técnicas de 
comunicação, computação e demais avanços tecnológicos, para sua integração à 
vida moderna. 

C) A participação dos idosos em atividades culturais e de lazer será proporcionada 
mediante descontos de, pelo menos, 30% (trinta por cento) nos ingressos, bem como 
o acesso preferencial aos respectivos locais. 

D) Os meios de comunicação manterão espaços ou horários especiais voltados aos 
idosos, com finalidade informativa, educativa, artística e cultural, e ao público sobre o 
processo de envelhecimento. 

 
Questão 22 

Considerando que tenha sido aprovada uma emenda à Lei Orgânica do Município de 

Patrocínio, é CORRETO afirmar que 

 

A) a emenda pode ser resultado de iniciativa popular. 

B) o projeto de emenda foi votado e aprovado em turno único. 

C) o quórum para aprovação da emenda foi o de maioria absoluta. 

D) a emenda será promulgada pela Mesa da Câmara de Vereadores. 

 

 

Questão 23 

São abrangidos pelo Regime Próprio de Previdência Social do Município de Patrocínio 

 

A) o prefeito e o vice-prefeito, nestas condições. 

B) os vereadores, nesta condição. 

C) os servidores exclusivamente ocupantes de cargo em comissão declarado em lei de 
livre nomeação e exoneração. 

D) os servidores ativos que estiverem afastados ou licenciados temporariamente do 
cargo efetivo, sem receber subsídio, vencimento ou remuneração do Município.  
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Questão 24 

Sobre o estágio probatório do servidor público do Município de Patrocínio, é CORRETO 

afirmar que 

 

A) o tempo de afastamento para o exercício de mandato eletivo é contado para fins de 
estágio probatório. 

B) o servidor já estável no serviço público do Município de Patrocínio nomeado para 
outro cargo de provimento efetivo fica dispensado do estágio probatório. 

C) o servidor não aprovado em estágio probatório será exonerado do cargo. 

D) não será concedida ao servidor em estágio probatório licença para o exercício de 
atividade política. 

 
 

Questão 25 

No âmbito do Plano de Cargos, Carreiras e Vencimentos do DAEPA, do IPSEM e dos 

Quadros Setoriais da Administração e da Saúde do Poder Executivo do Município de 

Patrocínio, não depende(m) de lei 

 

A) a previsão da natureza dos cargos ou das classes de cargos. 

B) as descrições de cargos. 

C) a previsão dos requisitos de escolaridade dos cargos. 

D) a transformação de cargos. 
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Conhecimentos Específicos  

 

Questão 26 

Observe a figura abaixo. 
 

 
 
Com relação a essa representação das vistas de uma peça simétrica, assinale a 
afirmativa CORRETA. 
 
A) Representou-se pela metade uma vez que a linha de simetria divide a vista em duas 

partes idênticas. 

B) Traçaram-se as arestas da peça um pouco além das linhas de simetria indicando 
continuidade naquela direção. 

C) Utilizaram-se dois traços curtos perpendiculares às extremidades das linhas da peça 
indicando descontinuidade naquela direção. 

D) Utilizou-se a representação do rebatimento da seção no espaço possibilitando a 
interpretação do sólido. 
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Questão 27 

Observe a escala de um escalímetro no 1. 
 

 
 

Considerando as medidas indicadas pelas letras, é CORRETO afirmar que 
 
A) A equivale a 1,0 m reduzido em 10 vezes. 

B) B equivale à distância de 5,0 mm. 

C) C equivale à distância de 0,5 m. 

D) D equivale à distância de 1,0 cm. 
 
 

Questão 28 

Observe esta perspectiva isométrica. 
 

 
 
Com relação às arestas numeradas dessa perspectiva, é CORRETO afirmar que as 
arestas 
 
A) 2 e 4 foram representadas em verdadeira grandeza. 

B) 2 e 4 apresentam uma redução no comprimento real. 

C) 1, 3 e 5 apresentam uma redução no comprimento real. 

D) 1, 3 e 5 apresentam o dobro da verdadeira grandeza. 
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Questão 29 

Observe estas vistas ortográficas. 
 

 
 
Assinale a alternativa que apresenta a perspectiva CORRETA da peça representada por 
essas vistas. 
 
 
 
 
 
 
A) 

 

 

  
 
 
 
B) 

 

 
 
 
 
 
C) 

 

 

  
 
 
 
D) 
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Questão 30 

Observe este desenho. 
 

 
 
Nesse desenho, a técnica de dimensionamento utilizada é a do dimensionamento 
 
A) alinhado. 

B) linear. 

C) ordenado. 

D) unidirecional. 
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Questão 31 

Observe uma peça representada por suas vistas. 
 

 
 
Nessa peça, a técnica de construção utilizada é a 
 
A) estampagem. 

B) extrusão. 

C) fundição. 

D) soldagem. 
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Questão 32 

Numere a COLUNA II de acordo com a COLUNA I associando cada sinal convencional 
de usinagem ao respectivo significado. 
 

COLUNA I  COLUNA II 
1. 

 

  
(     ) 

 
Superfície desbastada: os riscos da ferramenta 
são percebidos pelo tato. 

2. 

 

  
(     ) 

 
Superfície polida ou retificada: os riscos da 
ferramenta não são visíveis. 

3. 

 

  
(     ) 

 
Superfície em bruto, mas limpa com eliminação 
de rebarbas e saliências. 

4. 

 

  
(     ) 

 
Superfície sujeita a tratamento especial 
indicado sobre a linha horizontal. 

5. 

 

  
(     ) 

 
Superfície alisada: os riscos da ferramenta são 
pouco visíveis. 

6. 

 

  
(     ) 

 
Superfície laminada, estirada e forjada. 

 
Assinale a alternativa que apresenta a sequência de números CORRETA. 
 
A) (1) (4) (3) (6) (2) (5) 

B) (3) (4) (2) (5) (1) (6) 

C) (3) (5) (2) (6) (4) (1) 

D) (5) (3) (4) (2) (6) (1) 
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Questão 33 

Alguns projetos utilizam várias pranchas na sua elaboração que, ao final, serão 
ordenadas e numeradas. 
 
Ordene e numere de 1 a 6 as plantas abaixo. 
 

(     ) Baixas 

(     ) Cobertura 

(     ) Cortes 

(     ) Fachadas 

(     ) Locação 

(     ) Situação 
 
Assinale a alternativa que apresenta a sequência de números CORRETA. 
 
A) (1) (4) (2) (3) (6) (5) 

B) (2) (3) (6) (4) (5) (1) 

C) (3) (4) (1) (6) (5) (2) 

D) (3) (6) (4) (5) (2) (1) 
 
 

Questão 34 

De acordo com o conteúdo das plantas que compõem um projeto arquitetônico, assinale 
com V as afirmativas verdadeiras e com F as falsas. 
 
(    ) Os recuos e os afastamentos laterais, frontal e de fundo estão representados nas 

plantas de situação e de locação. 

(    ) As construções projetadas, existentes e a serem demolidas, são representadas na 
planta de situação. 

(    ) As plantas de situação e de locação são elaboradas, usualmente, utilizando a 
mesma escala de redução. 

(    ) Todas as medidas relativas às alturas serão transportadas dos cortes para as 
fachadas, incluindo as linhas de cota. 

(    ) A planta baixa apresenta a divisão dos cômodos, a localização dos equipamentos, 
das portas e das janelas. 

 
Assinale a alternativa que apresenta a sequência de letras CORRETA. 
 
A) (F) (F) (V) (V) (F) 

B) (F) (V) (F) (F) (V) 

C) (V) (F) (F) (V) (V) 

D) (V) (V) (F) (V) (F) 
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Questão 35 

Observe este desenho executado utilizando o Aplicativo AutoCAD. 
 

 
Assinale a alternativa que apresenta um comando desse aplicativo desnecessário à 
realização desse desenho. 
 
A) Dimension → Angled 

B) Draw → Circle 

C) Modify → Array 

D) Modify → Trim 
 
 

Questão 36 

O aplicativo AutoCAD apresenta vários níveis de trabalho – layers, camadas – com os 
quais é possível organizar e agrupar diversas informações sobre o desenho.  
 
Analise as seguintes afirmativas sobre as layers e assinale com V as afirmativas 
verdadeiras e com F as falsas. 
 
(    ) As layers permitem alterar suas propriedades tais como nome, cor ou tipo de linha.  

(    ) Nas layers ativadas, suas entidades ou objetos visíveis serão impressos. 

(    ) A troca de objetos selecionados entre layers é possível por meio do comando Layer 
Match. 

(    ) As variáveis e propriedades de um desenho atuam na layer corrente mantendo as 
outras layers inalteradas. 

 
Assinale a alternativa que apresenta a sequência de letras CORRETA. 
 
A) (F) (F) (V) (V) 

B) (F) (V) (V) (F) 

C) (V) (F) (F) (V) 

D) (V) (V) (F) (V) 
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Questão 37 

O aplicativo Excel permite modificar várias características de uma planilha tornando-a 
acessível a uma rápida compreensão das informações nela exposta. 
 
Analise as seguintes afirmativas sobre a formatação no Excel e assinale com V as 
afirmativas verdadeiras e com F as falsas. 
 
(    ) Os elementos individuais de uma Autoformatação podem ser modificados de modo 

que nem todos sejam aplicados em toda a planilha. 

(    ) Ao digitar um texto longo, o controle de fluxo de texto quebra o texto de uma célula 
tornando-o visível dentro do espaço destinado àquela célula. 

(    ) O compartilhamento de estilo entre planilhas é incompatível quando se trata com 
arquivos diferentes. 

(    ) A formatação condicional permite que o valor da célula determine sua própria 
formatação. 

 
Assinale a alternativa que apresenta a sequência de letras CORRETA. 
 
A) (F) (F) (V) (V) 

B) (F) (V) (V) (F) 

C) (V) (F) (F) (V) 

D) (V) (V) (F) (V) 
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Questão 38 

Observe esta imagem elaborada a partir dos aplicativos da Suíte MS Office que ilustrará 
um relatório. 
 

 
 
A criação dessa imagem é mais facilmente elaborada empregando o 
 
A) MS Excel e exportar a planilha para o MS Word. 

B) MS InfoPath e criar um link para o MS Word. 

C) MS One Note e anexar o arquivo no MS Word. 

D) MS Power Point, selecionar/copiar e colar no MS Word. 
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Questão 39 

Observe esta planta parcial de uma instalação elétrica. 
 

 
 
Em relação a essa instalação, assinale a alternativa que apresenta uma afirmativa 
CORRETA. 
 
A) A iluminação utiliza uma potência de 310 W empregando lâmpadas eletrônicas 

econômicas. 

B) Dois pontos de subida são utilizados: um na distribuição de sinal de TV e outro para a 
telefonia. 

C) O circuito de número 25 alimenta as tomadas dessa instalação em 220 V a três fios. 

D) Os circuitos de números 11 e 25 apresentam tomadas instaladas a 1,30 m e a 2,0 m 
do piso. 
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Questão 40 

Observe este detalhe de uma instalação de esgotamento sanitário. 
 
 

Escala 1:20 
 
Em relação a essa instalação, assinale a alternativa que apresenta uma afirmativa 
CORRETA. 
 
A) A caixa sifonada é ventilada por tubulações de diâmetros de 100 e 40 mm. 

B) A peça mais utilizada, em toda a instalação, é o joelho de 90o, totalizando cinco peças. 

C) Na conexão do vaso sanitário ao tubo de queda utilizaram-se quatro peças sendo trës 
joelhos de 90o. 

D) Utilizou-se o mesmo diâmetro nas tubulações que chegam e partem da caixa 
sifonada. 
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